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WHAT’S NEW? 
 
We are delighted to announce the release of version 8.3 of ONESOURCE Corporate Tax for the Netherlands. The 
release will allow you to prepare Dutch domestic taxpayer corporate income tax returns for FY 2015, and includes a 
number of features, enhancements and fixes. 
 
The release is available from our download site. In addition to the software installation, an update to your SQL Server 
fiscal unity database will be required. You will find the update script in the release package. 
 
If you are using ONESOURCE Corporate Tax in the hosted environment, you do not have to take any action; the new 
release is already available. 

2015 computations, extensions and 2016 preliminary assessments 

2015 domestic company only and fiscal unity tax returns can now be prepared in ONESOURCE Corporate Tax. These 
have been updated for the latest legislation, specification, tax rates and XBRL requirements. 
 
You can now also file extension requests for 2015 tax returns, 2016 preliminary assessment requests and requests for 
2016 SBA’s. 

GENERAL LEDGER MANAGER 
 
For our latest v8.3 release, we are delighted to be able to offer you a new option to collect data for your ONESOURCE 
Corporate Tax computations, by supporting integration with our General Ledger Manager solution. 

General Ledger Manager is a web based data collection tool, used to automate the flow of data from your GL / Trial 

balance into ONESOURCE Corporate Tax.  GLM also integrates with our Dataflow and Tax Provision solutions.   

GLM allows you to: 
 

 Define a tax-sensitive master chart of accounts, or multiple MCOAs for different purposes / company types 

 Import data from multiple ERP, GL and accounting systems (each potentially with a different chart of accounts) 
and consolidate data across reporting entities and divisions, to produce a single master trial balance at a legal 
entity level 

 Compare versions of trial balances, and make manual TB adjustments 

 Automate the data import into your financial information sheets in ONESOURCE Corporate Tax 

 Provides a clear audit trail from the numbers in the computation back to source data 

 It is easy to maintain with the ability to import/export  trial balance mappings and share mappings across entities 
and periods 

This will provide the following benefits: 

 Reduce the work involved in bringing data from source into computations, and re-work between compliance and 
other processes e.g. reporting 

 Work with large numbers of entities, mappings and volumes of data 

 Review and manage your work 

 Standardise your computations 

SUBCONSOLIDATION FILES 
 
We are pleased to offer support for consolidation hierarchies using our new subconsolidation module.  Subconsolidations 
provide you with greater flexibility in how you structure your files, and give you a better view of how your fiscal unity 
numbers are comprised. In addition to company files linking directly to the fiscal unity, you now have the option to include 
a subconsolidation file in between these two levels, or even multiple subconsolidation files.   
 
As part of this feature, you can choose whether the subconsolidation files are legal entities, with division files providing 
the data; or non-legal entities, to allow you to split your company structure into appropriate groups. 
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Potential advantages of including subconsolidation files in your file structure are: 
 

 Multiple users can work on consolidation simultaneously 
As only one user has write-access to the fiscal unity file at a time, dividing the fiscal unity into smaller 
subconsolidations first allows you and your colleagues to prepare different branches of your consolidation 
hierarchy simultaneously and speed up your process. 

 Faster interactions with the Fiscal Unity Database 
Large fiscal unities can require huge amounts of data, which means updating the fiscal unity data can sometimes 
take a while.  By dividing the fiscal unity into subconsolidations you will reduce the amount of data that needs to 
flow from the database, allowing for faster performance. 

 Division files 
Many of our customers have expressed an interest in preparing computations divisionally to match their source 
data, and rolling this up into a legal entity from within ONESOURCE Corporate tax.  We now support this with W 
files now being able to be marked as divisions.  In doing so, we alleviate some of the constraints and 
requirements that you would otherwise need to for a division.  We support the roll up of these into a legal entity 
subconsolidation file.   

Possible files structures with subconsolidations 

There is a lot of flexibility in how you structure your files with subconsolidations.  
 

Fiscal Unity file
 

Company File A
 

Company File B
 

Sub-consolidation
1 

Sub-consolidation
2

Sub-consolidation
 3 

Legal entity

Division A
 

Division B
 

Division C
 

 
 
As you can see in this example, the file structure can be very simple, as Sub-consolidation 1, where company files link to 
a subconsolidation, which links directly to the fiscal unity.  
 
Subconsolidation 3 demonstrates that the subconsolidation can be a legal entity, with the company files that are linked to 
it representing divisions: 

 
 
 
 
 

 

 

 

 

 

 

 

Fiscal Unity file
 

Division A
 

Division B
 

Sub-consolidation
 3 

Legal entity
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You can also have as many subconsolidation files in between the company files and fiscal unity as you require: 

 

Fiscal Unity file
 

Company File A
 

Company File B
 

Sub-consolidation
1 

Sub-consolidation
 …..Sub-consolidation

2

 

Preparing Subconsolidation files 

Subconsolidation files have been included as a new option in the file creation menu. 
 
Please note that subconsolidations are currently only available for domestic 
computations from 2015 onwards. 
 
The basic operations of a subconsolidation file are very similar to those available in 
fiscal unity files. The Fiscal unity control sheet (F) provides an overview of which 
files have been linked to the subconsolidation, and from here you can link or 
remove companies from the consolidation, and update the data from the database. 
 
These options are also available in the File > Link menu, where you will notice that 
the option to ‘Upload company data for fiscal unity’ is available, which uploads 
information which consolidates at subconsolidation level; e.g. Balance sheet 
information, to the fiscal unity database. Data is also uploaded to the database 
when the file is saved, in the same way as company files. 
 
Other options on F sheet, such as ‘Open, update and close all files’ and ‘Set status 
of all files to…’ are also available in subconsolidation files. These operations will be 
performed on all the files below it in the chain, e.g. in the company structure shown above, pressing ‘Set status of all files 
to…’ in Subconsolidation 2 will change the file status of Company A, Company B and Sub-consolidation 1. Note: this 
operation is not performed on the file itself, or any file higher in the structure, i.e. the fiscal unity file. 
 

Data consolidation when using subconsolidation files 

To make the use of subconsolidation files as efficient as possible, we have used different methods of consolidation, 

aggregation and post-back to suit the type of information within your files. 

For example, to allow you to perform and use balance sheet and P&L adjustments and eliminations from each level in the 

hierarchy, data for these sheets is taken from the level immediately below it.  Using the first file structure shown above as 

an example, the balance sheet of Company A 

and Company B will be consolidated into 

Subconsolidation 1. The fiscal unity file will then 

show the consolidated amount from 

Subconsolidation 1, rather than the underlying 

company data. 

 

 
The F2 sheet in the fiscal unity file, showing 1 

column for the ‘Subconsolidation 1’. 

 

 
Data from the Taxable amount (T-sheets) adjustments and double tax relief are not consolidated at every level, but the 
data entered at the lowest level is shown directly in the consolidation files. 
 
For the filing purposes, a fiscal unity file must show certain information which has been consolidated at legal entity level. 
Items such as loss compensation can only be calculated at legal entity level, and so this is uploaded to the fiscal unity 
from the legal entity file, which can either be a company file or a subconsolidation file. 
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Fiscal unity

Loss compensation
BS/PL data for L4/L5 sheets

BS/PL data of 
entity

BS/PL data of 
sub-consoidation

Fiscal unity adjustments
Loss compensation data

BS/PL data of 
entity

Taxable amount (T-sheet) adjustments
Double tax relief

Legal entity
(Company or sub-
consolidation file)

Company or division file
(non-legal entity)

Sub-consolidation 
file

 
A summary of the data flow in a subconsolidation file structure. 

 
A full list of how data is transferred in subconsolidation structures, please see the Appendix. 

Fiscal unity adjustments and loss compensation 

As fiscal unity adjustments and loss compensation are made between legal entity companies, these are posted back to 

the legal entity file from the fiscal unity file, in the same way as it would if there were no linked subconsolidation files. 

Note that any fiscal unity adjustments entered into the subconsolidation file are for information only, and do not post back 

to the legal entity file. 

PARTICIPATIONS 
 
Many of our customers have a large number of participations, and have been requested by the tax authorities to provide 
more information on their participations where they have a large number of subsidiaries.  This is because the authorities 
have a limit of 99 participations for eFiling.  We have worked closely with Belastingdienst to deal with situations where 
companies may have more than 99 participations, and have developed a new Specification: participations sheet.  All 
participation filing is done through this sheet, which also re-works how we deal with this situation.  

This sheet is developed as part of your Tax return for e-filing group of sheets for all domestic filings, and is consistent in 

layout to the other sheets in this group. 

 
 
From 2015 onwards, where you have 100 or more participations, the behaviour is somewhat different to previous years.  
These differences are the outcome of work with the tax authorities to ensure you disclose the information they need: 

 Your participations will be sorted, listing the ones that the authorities are most interested in at the top 

 The name of the last (99
th
) participation will be “Summary of other participations" 

o   

 Some values will be aggregated (e.g. the cost price); others will be the value of the top-ranked of the remaining 

participations (e.g. fiscal number), and others will not be disclosed (e.g. merger/demerger information) 

With this change we have also changed how the Specification – participations (D) sheet prints, which will now include in 

your final print report the entire list of participations, including both those within and outside of the fiscal unity.  
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To make your participations easier to enter, we have also made it possible to develop multiple Participation analysis 

quickly, using a new option: 

- Toolbar: Tools > Application tools > Add multiple participation schedules 

- Ribbon bar: Application Tools > Add multiple participation schedules 

Clicking this option will load a dialog in which you can specify the number of participation sheets you wish to add to your 

calculation. 

F SHEET FUNCTIONALITY IN FISCAL UNITY AND SUBCONSOLIDATION FILES 
 
You will notice that there we have made some changes to the Fiscal unity control sheet (F), which should make the 
process of completing your consolidations more efficient and convenient. These improvements are available from 2015 
computations onwards. 
 

 
 

The new look F sheet in 2015 consolidation files 

Bulk changing of file status 

We have replaced the ‘Set status of all files to CLIENT’ button on the F sheet to make this far more flexible.  Instead of 
setting the status for all the computations linked to the fiscal unity to “CLIENT”, you now have the option to select any 
status to which you would like to set all files.  This gives you greater freedom to configure your own statuses, and use 
those in a meaningful way with the fiscal unity.  It also saves you time when unlocking all files, whilst retaining the 
password and audit controls you will be familiar with when performing this file-by-file. 
 
To use this functionality, select a status in the drop-down menu under the file status column (1), then press the ‘Set status 
of all files to …’ button. This will set the status of all the files in your consolidation to the required status.  Note: If you have 
subconsolidation files in your file structure, this function will set the status for all files beneath it in the structure, i.e. 
selecting this option in a fiscal unity file will change the status for all subconsolidation files and any files that are linked to 
those subconsolidation files as well. 

Errors in linked files 

You will also see that we have included a count of the number of errors in the files which have been linked to the F sheet 

(2). This will help you to quickly and easily identify which computations have issues which need to be dealt with before 

completing your fiscal unity computation. 

Where applicable, the number of unanswered queries, old link errors and data access errors in each file will also be 

displayed. 

Note: The error count information is updated using the fiscal unity database, so a connection to the database is required 

to update this. 

Parent company selector 

We have made some changes to the parent company selector as well. By clicking ‘Select parent company’ (3), a dialog 

box will appear displaying a list of all the legal entities which are in the consolidation.  If you wish to de-select the parent 

company, use the ‘Clear parent company’ button. 

1 

2 

3 
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In subconsolidation files, if the parent company of the fiscal unity is not contained within that subconsolidation, you can 

suppress any errors you relating to the absence of a parent company. 

Batch printing of files in consolidations 

We are pleased to announce that the ‘Print all files in fiscal unity’ functionality that we previously introduced is now 
finalised, and we have included some significant improvements. 

 
 
New options are now available under Tools > Application 
tools > Batch print files in fiscal 
unity/subconsolidation’ when using the toolbar, or 
Application tools > Print all files in fiscal 
unity/subconsolidation’ when using the ribbon bar: 

 
 
 

The batch printing options in a fiscal unity file 
 
To give you greater flexibility and control, we have provided 3 options for which files to print: 
 

 Print all linked files will print all files in your file structure. If the file structure contains subconsolidations, this 

option will print all subconsolidation, company and division files attached to this file. 

 Print all files shown on F sheet will print only the files that are listed on the F sheet.  If any of these are 
subconsolidations, it will print the subconsolidation file, but not any files below it. 

 Print all legal entities will look through the file structure, and print any files listed as legal entities. 

FISCAL EQUITY PICK UP  
 
Explaining an equity pick up is a challenging and time-consuming part of fiscal unity consolidation.  For 2015 filings 
onwards, we have developed a sheet to report out your reconciliation.  The new Fiscal Unity Equity Pick Up sheet is 
developed from Fiscal Unity Control sheet (F) in your domestic fiscal unity consolidation file (xxx_Fxx.ABC).  
 

 
 
This new sheet reconciles your position for each fiscal unity member’s (1) balance sheet (4) with the consolidated 
participation position per its parent’s balance sheet (3).  This works by matching the fiscal numbers (2) for each domestic 
legal entity against the participation number.  Where differences arise, we net this difference against the P&L result and 
dividends paid (5) for each participation, and an additional column for other manual adjustments, to get to your net equity 
position (7).   
 
In case you have foreign fiscal unity members, we also provide an additional table (6) for you to be able to manually 
perform a similar reconciliation for such members. 

  

1 2 3 4 5 

7 6 
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SERVER REPORTING ENHANCEMENTS 
 
We have improved the server reporting functionality by increasing the number of items that you can produce reports on. 
 
You will be able to report on more balance sheet and P&L values via the tax return schedules (‘Balance sheet – Assets’, 
‘Balance sheet – Shareholders’ equity and liabilities’ and ‘Profit and loss account’), which will give a more detailed 
company overview for the financial year. You should be able to report from the Tax Return sheets (A1xx), Participations 
(D), Taxable Income (T), Loss Compensation (U) and Tax Calculation (V). 
 
We are also making standard reports available for different categories, via the new templates which we are including. For 
a full list of standard reports which will be added over the coming year, please see Appendix B. 
 

OTHER IMPROVEMENTS 

Excessive participation interest 

We have also improved our calculation of excessive participation interest for this release.  The participation debt is now 
based on the average of the participation debt as per the beginning and the end of the financial year.  In addition, you can 
now report loans payable and interest on a gross basis and adjust if interest on loans payable is already non-deductible 
based on other Dutch corporate income tax legislation. 

Irrelevant questions on A sheet can now be hidden 

We have added a selector (‘View general information in full’) at the bottom of the General information sheet (A) to allow 
you to view/hide information that is not required to be filed with the tax authorities, per their electronic filing specifications.  
By default the non-mandatory information will be hidden; however, if aforementioned selector is set to YES the general 
information is shown in full in line with previous years. 
 

 

Non-mandatory section on A9 sheet has been removed 

The non-mandatory section on the General information and specifications - Page 2 sheet (A9), indicating which 
specifications should be filed with the tax authorities, has been removed. This is because the mandatory tax return 
specifications are automatically included in the XBRL file generated for electronic filing, and an additional specification is 
therefore no longer needed. 

Minor improvements to printing, general functionality and localisation 

In line with previous releases we have enhanced the print and general functionality and we have further localised the 
software.   
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APPENDICES 

APPENDIX A: CONSOLIDATION OF DATA IN FILE STRUCTURES USING SUBCONSOLIDATION FILES 

Consolidation type Sheet name Sheet reference 
Sheets which consolidate at 
every level 

Balance sheet  
 

B 

Profit/Loss sheets C 
Interaction is directly 
between fiscal unity and 
legal entity file 

Company level data L4, L5 
 

Loss compensation U4, U7 
Populates from lowest level 
file (division or company 
file) 

T sheets:  

Non-deductible expenses T4 

Investment allowance T5  

Disinvestment charge T6 

Non-deductible interests T8 

Deductible donations T10 

Fundraising activity T13 

Non-deductible interest and royalties (art. 8c CITA) T16 

Profit from Seashipping T17 

Specification Innovation box T19 

Specification - Object exemption T21 

Specification - Research and development T22 

Excessive participation interest T25 

  

V sheets – Double tax relief  

Exemption method V1 

Credit method for dividends, interests and royalties V2 

Credit method for foreign income on passive investments V7 

Royalties in innovation box V8 

  

Participations D2 

APPENDIX B: STANDARD REPORTS IN SERVER REPORTING 

The following is a list of standard reports which will be available in when using server reporting. These templates will be 

made available during the year. 

 

 Tangible Fixed 

Assets 
 Obligations and provisions  Financial Income and Expenses 

 Financial Fixed 

Assets 
 Long term debts  Results from participations 

 Stocks  Short term debts  Extraordinary Income 

 Receivables  Operating income  Extraordinary Expenses 

 Securities  Cost of raw materials  Fiscal Profit 

 Liquidities  Employee related costs  Recon fiscal tax amount 

 Shareholders’ Equity  Depreciation  Total tax payable 

 Equity  Other operating expenses 
 

 Participations  Loss compensation carry back 
 


